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Introduction
This guide covers the new features and improvements offered in 
Freeway 7.

While the main new feature is support for building responsive 
websites—which has meant that a huge amount of work has been 
done in many different areas so it all integrates into a cohesive 
workflow—other new features and improvements have been 
included.

The new features are listed in the next section—then each new 
feature and improvement is discussed in detail (in the same order 
as they appear in the “at a glance” list). 

To understand some of the new features—especially the new 
responsive features—brief tutorials have been included so you 
can create a new file and follow the steps to see how it works and 
what the various options do.

New features at a glance
•	 1—Responsive Layout: The main new features here are in the 

support for “media types” and “media queries” (see below) for 
working with page and items.

•	 2—Responsive CSS Menus Action: The original Action has had 
a lot of work on it to make it work with responsive layout. It 
is now possible to build a drop-down-and-fly-out menu for 
viewing on standard desktop browsers, which can then be 
made to display as an icon to click on when viewed on mobile 
devices. Clicking on the icon will reveal a mobile-friendly 
drop-down menu (which fills the screen of devices such as an 
iPhone) while still retaining the same Normal, Hover, Click 
and Current Page states as applied to the desktop browser 
version of the menu. 
Auto-Generate Navigation Menu: Another new feature to the 
CSS Menus Action which lets you auto-generate the menu by 
taking the page and page folder structure within a Freeway 
file’s Site Panel to build the menu (including sub-menus and 
sub-sub-menus). 
Remove from CSS Menus Action: A new Action which lets you 
choose to not exclude specified pages from the CSS Menu (for 
example Success and Error pages used by a contact form). 
Bold attribute for Current Page State: CSS Menus now supports 
a specific option to choose Bold for the Current Page state 
when the menu displays in a browser (in addition to showing 
a different link color and background color/image.

•	 3—Better Meta Action: A new Action which offers a quick and 
simple method to include meta data for social media. 

•	 4—Table Styler Action: A new Action to add elegant styling to 
HTML tables. 

•	 5—Enhanced Google Analytics Action: The enhanced Google 
Analytics Action in Freeway 7 takes advantage of new features 
offered with Universal Analytics.

•	 6—New HTML5 Section Elements: In addition to the list of 
different HTML5 section elements, Freeway 7 now supports 
Figure, Figure Caption and Main.
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•	 7—New keyboard shortcuts: A whole host of new keyboard 
shortcuts have been included in Freeway 7 to enhance the 
workflow within the application. Many dialogs which could 
only be opened through dropdown menus previously can now 
be accessed through simple keyboard shortcuts.

1: � Working with pages when building a 
responsive website

All modern browsers now offer support for “media types” and 
“media queries”, and Freeway 7 lets you take advantage of these 
to make websites which automatically adjust their layout when 
viewed in a browser window at narrow widths (or on a mobile 
device) at pre-determined “breakpoints” which trigger changes in 
the layout according to how wide the browser or device’s screen 
is. As soon as a breakpoint in reached, pages and items use CSS 
to change certain attributes so the layout will work better at that 
screen or browser width (for example when columns of content 
begin to look too narrow). 

The attributes you can change at those breakpoints fall into two 
distinct categories—those which are applied to the page itself, and 
those which are applied to items used on the page. In this section 
we’ll concentrate on the ones which are applied to the page (you 
can read about the ones which are applied to items in the Working 
with Items chapter) along with how to work with pages when 
buildings websites using a responsive layout.

We recommend building your sites in percentage-based inflow 
layout—as that will mean that there will be a gradual progression 
to the width of the pages (and the items on the page) before the 
breakpoint is reached.

Page attributes which can be changed using 
media queries (breakpoints)
There are many different page attributes which are currently 
supported in browsers when working with responsive layout. 
Although more may be added over time, these are currently:

•	 Alignment: This lets you change how the page aligns in 
a browser when the breakpoint is reached, but note that 
alignment is not supported on mobile devices because the page 
displays so that it scales to the same width as the page width.

•	 Background: This lets you choose a different color for the 
background of the browser (ie, the area outside of the page 
area if you have a page background set) when the breakpoint 
is reached. Note that you will not see a background displayed 
on mobile devices unless you allow for space either side of 
your page content area (but within the page width of your 
document) which has no background color or image applied.

•	 Background image: This lets you choose a different background 
image in the background of the browser window when the 
breakpoint is reached. Like Background, you need to be aware 
you will not see a Background image display on a mobile device 
unless you allow for space either side of your page content area 
(but within the page width of your document) which has no 
background color or image applied.
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•	 Dimensions: This lets you choose different dimensions for your 
page size when the breakpoint is reached.

•	 Guides: Although this won’t affect the actual layout of your 
page, this lets you use a different set of guides on your Freeway 
page for the pages set to different media widths.

•	 Margins/grids: Like the above attribute, this will not affect the 
layout or output of your file, but it lets you set up different page 
margins for each breakpoint to help you build your pages in 
Freeway.

•	 Min/Max dimensions: If you use Min/Max dimensions in the 
Width popup of the Inspector for your pages, you can choose to 
use different values at each breakpoint.

•	 Padding: This lets you choose a different Padding value applied 
to your page so it can be different at each breakpoint.

•	 Page background: This lets you choose a different color for 
your page area when each breakpoint is reached.

•	 Page background image: The lets you choose a different image 
to display in the page area background when each breakpoint 
is reached.

A very brief getting started tutorial for 
working with responsive layout
The tutorial here gives simple steps (using a single item on a page) 
to show the concepts of how you need to work in Freeway to 
create a responsive layout. A much more in-depth tutorial—where 
you can build a proper site as you read through the tutorial—
appears in the Appendices section at the end of this manual.

Although we tend to recommend that you build your pages using 
percentage-based inflow layout, it is also possible to build your 
pages using items which are positioned as absolute (layer) items as 
well. 

The main advantage of using inflow layout is that you can simply 
resize the width of the page at each breakpoint (so it matches the 
pixel width of each particular media widths used—so that Freeway 
will automatically resize the page “container” item and reposition 
all the items inside it according to their percentage widths). If your 
layout is not inflow, you will need to resize and reposition each of 
your items manually, which can take a lot longer to do.

This basic tutorial covers the workflow for working with non-
inflow as well as inflow layout. However, you should read all of the 
following tutorial, as the steps are not repeated for both workflows. 
As always, the best way to learn is to work in Freeway as you read 
through the steps of this tutorial.

By setting up a Master page (or Master pages if you need to use 
more than one Master), you can make it so each new page you 
create already has the common items on your pages set up so they 
are positioned as you want in each of the media widths you want 
to use. This will mean that you only need to edit the page’s new, 
unique content to just that page for each media width.

Working with responsive layout with non-inflow items

Launch Freeway, go to File>New, create a new file from the Blank 
template, choose a location to save the file to your hard disk 
(perhaps your Desktop) and click OK. Select the Master page, 
give the page a Width of 1050 pixels and a Height of 1000 pixels 
then choose Center in the Align popup in the Inspector’s General 
Settings tab. 

Make sure the CSS Layout button is switched on (so it displays in 
blue with the wording CSS Layout displayed underneath) and the 
Default button is selected in the row of Media Width buttons above 
the top left of the page area. 

Click on the Inspector’s Paintbrush tab, choose Cyan as the color 
in the Window Background panel, then draw an HTML item on 
the page, resize it so it fills the width of the page area and has a 
height of around 250 pixels and give that item a Background Color 
of Yellow.

Because the Default button is selected in the row of media width 
buttons above the top left of your page area, you will see the page 
displaying as it usually does in Freeway.

Click on the Tablet: 768 button in the row of pre-set media width 
buttons and you will now see a semi-transparent red area on the 
right-hand side of the page—which is called the Media Width 
Overlay. 

In the screenshot above you can see that the Media Width Overlay 
gives you a visual cue that the usable width of the page is now less 
than the default size. Because the page width was set to 1050 pixels 
wide, clicking the pre-set media width of Tablet: 768 will show you 
a representation of how much space you have to work with for 
that breakpoint (ie, you only have 768 pixels for the width at that 
breakpoint rather than full page width of 1050 when working with 
the default button selected).

Earlier it was stated that the Media Width Overlay area displays as a 
semi-transparent red color—however because it is semi-transparent 
the cyan and yellow are visible behind it, and this makes it display 
as blue/green and orange on the above screenshot. When working 
with a white background, the overlay area will display as a shade of 
red—as shown in the screenshot at the top of the next page.
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Choosing a narrower media width, the red area changes to give 
a graphic representation of how wide the page will be at that 
breakpoint (again, based on the initial width value used on your 
page for the default width). Click on the Phone: 320 button to 
see that the Media Width Overlay covers most of the width of the 
page (as shown below).

It is important to point out here that the Media Width Overlay 
area is simply to give a visual cue of the difference between the 
page width that’s set on the document and what the width of any 
breakpoint will look like compared to that original page width. 
Note that the red area does not prevent you positioning items 
in that area and nothing will happen automatically to make 
the content change (even when items are inside that red area). 
Essentially, you need to resize or reposition items so they do not 
appear in that area—but with non-inflow items you will need to 
do that manually (see later).

It is possible to switch off the Media Width Overlay by going to 
the View menu and switching off the Media Width Overlay option 
(which is switched on by default). 

However, as it is a valuable tool for seeing the width you have 
available for each media width (and also to act as a reminder), we 
recommend you leave it switched on.

We can now set up some very basic responsive behavior. Click 
on the Tablet: 768 button. Change the Window Background of 
the page to Yellow, then select the HTML item and change the 
Background Color to Green. Finally, give the HTML item a Width 
of 768 pixels (ie, the width of that breakpoint, which will make the 
item fill the available width from the left side of the page to where 
the Media Width Overlay red panel begins).

As soon as you do this you will see that a black dot has appeared to 
the left of the Tablet: 768 button name. Although this looks similar 
to the dots which appear to the left of pages in the Site Panel 
(when an edit has been made since the file was last published) it is 
important to note that these dots simply tell you that one or more 
media changes have been made at that breakpoint (they won’t 
disappear when you next publish the file).

This is a good time to mention that the row of different media 
widths works in such a way that changes made in a wider media 
width preset will cascade down all the narrow media width 
presets. This means that when you first set up the Default media 
width, all the other media width presets would use those exact 
settings for the page and the items on the page. Now that we have 
made changes to the Window Background of the page and the 
Background and Dimensions of the HTML item, if you click on 
any narrower media width preset button you will see that they 
all now display things exactly as they are used at the Tablet: 768 
breakpoint.

The reason why Freeway works like this is so that—as long as you 
start at the Default preset and then work with each media width 
button to the left each time—each edit will be respected at the 
next media width down, and this prevents you needing to make 
repeated edits at each media width. It is important, therefore, to 
always work from right to left in order of the media width buttons, 
because if you work from left to right you will need to make those 
same edits at each different media width.

Going back to the tutorial, another thing you will see is that when 
the HTML item is selected on the page at the Tablet: 768 media 
width, two new panels at the foot of the Inspector’s General 
Settings tab now show some information in the Current Media 
Changes and Changed Media Types panels.
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With the HTML item selected, you can see that the Current Media 
Changes panel has the words Background and Dimensions listed 
inside it. This tells us that the HTML item has had two changes 
made for that breakpoint—which are that the Background Color 
was changed for the item and we also changed the width of the 
item to fit the 768 pixel wide media width for that pre-set.

The Changed Media Type panel tells us that so far the only 
changes made in breakpoints have been made at the Tablet: 768 
media width.

Now deselect the HTML item (by clicking on a blank area of the 
page or on the pasteboard area) so you can see the Inspector’s 
General Settings for the page itself. Here, you will see that the 
Current Media Changes panel now lists just Background. You 
might remember that Background was also listed when the 
HTML item was selected, but it is important to note that the one 
listed when the HTML item was selected referred to the item’s 
Background Color, while the Background mentioned when 
nothing is selected on the page refers to the Window Background 
attribute for the page itself. Also, it should be pointed out that 
if you change the Page Background attribute for the page, the 
Current Media Changes panel will display Page Background in the 
list.

This also highlights the fact that the information displayed in the 
Changed Media Type panel is “context-sensitive”—so it will only 
show the changes to attributes made to an item selected on the 
page (or to the page itself if nothing is selected on the page). When 
you have many different items on your page you can select each 
item in turn to see what attributes have changed for that item.

Another way to tell that an item has been edited in a particular 
media width is to go to that media width and see which items 
display their name in bold type (in the screenshot below, item2 has 
been edited at the current breakpoint).

This is now a good time to try previewing the page in a browser, 
so click on the Browser button and view the sample file by making 
the browser window very wide. If you have a normal sized screen 
to view the page on, you should see the page in its Default media 
width state (ie, with a cyan Page Background and a yellow HTML 
item). However, if you now resize the browser window so the 
width gets smaller and smaller, you will see that the page content 
changes to the settings used at the Tablet: 768 media width (so 
the Window Background changes to yellow and the HTML item’s 
Background Color changes to green.

Although it is not easy to see in the browser, this change takes 
place when the web page is viewed in a browser window which 
has a width of 768 pixels or less. Unfortunately, there is no current 
pixel information given for width given in the standard options 
offered in web browsers (though some plug-ins you can download 
for the browser of your choice are now being released).

Because of the deficiencies of viewing pixel-specific widths for 
pages in a browser, we have made Freeway’s built-in Preview work 
in such a way that it will show the page at the correct pixel width 
for that particular media width. To see this working, click on the 
Preview button (just above the media width buttons) and you will 
see that the Tablet: 768 media width page displays at 768 pixels 
wide, with grey either side of it. 

While still in Preview mode, try clicking on the Default media 
button to see that the colors used at that width now display. This 
makes Freeway’s Preview a valuable tool for testing your pages 
when setting up your media widths.

Now click on the Phone (Landscape): 480 media width button and 
change the page’s Page Background to Magenta, change the HTML 
item’s Background Color to White, change the item’s Width to 480 
and then click on the Preview again to see that the page content 
changes at two different breakpoints when the browser window is 
made narrower.

Important: If you set a breakpoint at Phone: 320 you will probably 
find that you can’t make the browser window small enough in a 
desktop browser to trigger that breakpoint. To test that breakpoint 
you will need to either upload the page and test it on a mobile 
device with a screen width of 320 pixels or less, use Freeway’s 
Preview or use Apple’s iPhone Simulator. 

To get Apple’s iPhone Simulator you need to go to the App Store, 
download and install Xcode. Once it’s installed you can then click 
and hold on Freeway’s Browser button, choose Browser Setup and 
click Update. You should then be able to see the simulator in the 
list of browsers you can use.

Working with responsive layout with inflow items

Now that you have worked through the steps in the previous 
section, we can now explore the differences—and advantages—
offered by the following method. As you will see here, the main 
advantage is that setting up your different media widths can be 
far simpler if your pages are built using inflow percentage-based 
layout, because the page itself is set up as a “container” for all the 
items on your page—so selecting the page container item (or the 
page itself) and then changing its width will automatically force all 
items inside it to reduce in size at the same time.

To show how this works, click on the Default media width button 
then select and delete the HTML item created in the previous non-
inflow section by hitting the Backspace/Delete key. Now, because 
we are working with inflow layout, you first need to double-click 
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in the page area itself (so you can see the flashing text cursor in the 
top left corner of the page area) and then go to Insert>HTML item 
to place an HTML in the flow of the page div.

Command-click on the new HTML item you inserted, then select 
the item on the page. Go to the Inspector and set the Background 
Color of the item to Yellow (leave the Page Background color set 
to Cyan), then set the Width popup in the Inspector’s General 
Settings tab to Available (which will make the item fill the page’s 
width of 1050 pixels).

Now click on the Tablet: 768 button, make sure nothing is 
selected on the page, then change the Width of the page in the 
Measurements panel of the Inspector to 768 (which will make the 
page the same width as the media width we’re using).

 

You will now notice that the Media Width Overlay area has 
disappeared—which is because the page width is now the same 
width as the media width we’re using. 

Also, because the HTML item has a Width value of Available, it will 
automatically change to fill the width of its parent container item 
(in this case the page), so now that the width of the page is set to 
768 pixels, the HTML item will fill that width. Because you can 
make all inflow items automatically adjust to the width of their 
container items, this shows how spending a little extra time when 
building the Default page will offer benefits when later getting the 
responsive behavior set up.

Select the yellow HTML item and set the Background Color to 
Green, then preview in a browser or use Preview to see that this 
works in exactly the same way as it did when absolute positioned 
items were used by changing the sizes of the items on the page 
manually.

Now click on the Phone (Landscape): 480 media width button, 
change the width of the page again (using the same method as 
with the previous media width) then change the Background Color 
of the HTML item to White and either preview in a browser and 
make the browser window narrower to see the changes at each 
breakpoint or use Freeway’s Preview then click on the different 
media width buttons.

Editing or removing existing media types
If you want to make a new edit to a page or item attribute for a 
particular breakpoint, click on that breakpoint button, select the 
item and make the edits or, to edit page attributes, make sure 
nothing is selected on the page then make the edits.

If, after applying an attribute or editing an existing attribute to a 
page or an item, the simplest way to remove it at that breakpoint is 
to select the attribute’s name in the Current Media Changes panel 
and hit the Backspace/Delete key on your keyboard.

Selecting and deleting a media type in the Changed Media Types 
panel will delete all changes made at that breakpoint.

Another way to remove all changes made at any particular 
breakpoint is to go to that media width, then go to the Page menu 
and choose Reset Current Media Type. This will display a warning 
dialog which asks “Do you want to clear the current media?“. Click 
OK to remove all changes.

Note that there is no way to restore those edits later once you have 
reset them.
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Setting up custom media widths
Although Freeway comes with a set of default pre-set media widths, 
you can always edit the buttons which show in the row of buttons 
above the top left of the page area, and you can choose to add 
your own buttons too.

To do this, go to the Edit menu and choose Media Types... to bring 
up the Edit Media Types dialog.

•	 Other media: Check the Print option if you want to set up a 
different sort of media type than we have used so far. There 
are many different media types but Freeway currently supports 
the two most common types—Screen and Print. The other 
media types (such as Speech, Braille, Projection, Handheld, 
TV, etc.) are less useful then they might appear: mobile 
phones identify themselves as Screen media (not Handheld), 
and options that might seem to be useful for accessibility are 
largely unsupported. Safari (for example) takes no notice of 
Speech media when Speech and VoiceOver options are used. 
  The Print media type can be used to provide a printable 
form of a web page, which might omit elements that are 
irrelevant or distracting on printed media, such as navigation 
bars, for example. 
  There is only one Print media type (it is either a Print media 
type or not) so by checking the option and clicking OK, 
you will see a Print button appear in the row of media type 
buttons above the top left corner of the page area. 

•	 Add: To add a new screen media type, click on the Add button, 
enter a value for the Width of the new type in the Width 
column (note that you must enter a numeric value). After 
that you need to click in the Description column to enter the 
wording you want to appear on the new button’s name along 
with the width value entered in the Width column. Click OK 
when you have finished to close the dialog. 
  Below is a screenshot of the row of media width buttons 
after a new custom screen type has been added. 

 
  To edit the new custom media type, go to Edit>Media 
Types..., simply double-click in either the Width or Description 
column, make the changes and click OK.

•	 Delete: To delete one of the default pre-set media types or to 
remove a custom media type you have added, select the media 
type in the list, click the Delete button then click OK.

Working with items when building a 
responsive site
Just as Freeway can be made to change the CSS attributes of a page 
so it can be made work in responsive layout, the items used on the 
page can also be made to change at each media width breakpoint 
you set up.

A list of item-specific CSS attributes that can be used at each 
different media width in Freeway appears below.

To change the attributes of an item you first need to select the item 
on the page and then apply, remove or edit the attributes in the 
Inspector (or, in the case of using Extended Style Properties, in the 
<div style> tab of the Extended Attributes dialog).

Important: You will only be able to work with media types if the 
item you have selected is a layer item (if you select a table-based 
item you will not see functionality for using media types)—so 
always make sure you have the CSS Layout button switched on 
while you work.

Item attributes which can be changed using 
media queries (breakpoints)
There are many different page attributes which are currently 
supported in browsers when working with responsive layout. 
Although more may be added over time, these are currently:

•	 Alignment: This lets you change how the inflow content within 
an item aligns when the breakpoint is reached.

•	 Background: This lets you choose a different Background Color 
for an item when the breakpoint is reached.

•	 Background image: This lets you choose a different image 
to display in an item’s background when the breakpoint is 
reached.

•	 Border: This lets you choose different Border attributes for an 
item when the breakpoint is reached.

•	 Clear: Clears are used in web design to control whether other 
inflow items within the same text flow appear on the same line 
or not. This option lets you change the Clear attributes of items 
when the breakpoint is reached.

•	 Dimensions: This lets you choose different dimensions (width 
and/or height) for an item when the breakpoint is reached.

•	 Height: This lets you choose a different Height attribute 
(Minimum, Flexible, etc.) for an item when the breakpoint is 
reached.

•	 Margin: Margins in web design work in a similar way to 
Padding except that the amount of pixels used for Margins will 
be added to the outside of an item (whereas with Padding the 
amount of pixels will be added to the inside of an item). This 
lets you choose different Margin attributes for an item when the 
breakpoint is reached.

•	 Min/Max dimensions: Although there are no specific options 
in the Width or Height popups for HTML items (whether they 
are inflow items or not), you can manually edit the Minimum 
or Maximum Width values and the Minimum or Maximum 
Height values in the Dimensions panel of the Inspector to use 
the values you want.

•	 Opacity: This lets you choose a different Opacity value for an 
item (HTML or graphic) when the breakpoint is reached.

•	 Overflow: This lets you choose a different Overflow attribute 
(Visible, Hidden, Scroll or Auto) for an item when the 
breakpoint is reached.
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•	 Padding: This lets you choose the different Padding value for an 
item when the breakpoint is reached.

•	 Position (Absolute or Fixed—for layer items): This lets you set 
the layout behavior of a non-inflow item when the breakpoint 
is reached.

•	 Shadow: This lets you choose a different CSS3 Shadow 
attribute for an item when the breakpoint is reached.

•	 Display: This lets you make an item invisible when the 
breakpoint is reached. 
  To hide an item, select it on the page and go to the Output 
Settings tab of the Inspector. In there you will see an option 
for Display. Uncheck the option to hide the item at that 
particular breakpoint or check it to make it visible again. 

•	 Show: The Display attribute should not be confused with the 
Show option that displays in the General Settings tab of the 
Inspector when a non-inflow item is selected on the page. 
The Show option offers a way to hide an item in the Freeway 
interface only (for example, hiding a large Target Show/Hide 
Layer item which is sitting on top of the page content so you 
can make edits to text, etc., behind it). However, you need to 
be aware that even though that item is not displayed on your 
Freeway page, it will still appear in the published layout when 
previewed or uploaded to the web.

•	 Width: This lets you choose a different Width attribute (Fixed, 
Fixed % or Available) for an item when the breakpoint is 
reached.

•	 Extended Style Properties: If you wish to invoke a new style 
attribute at a particular breakpoint you can select an item (or 
text inside an item) then go to Item>Extended, click on the 
<div style> tab and then enter a Name and Value pair for the 
new style.

2:  Responsive CSS Menu Action
The CSS Menus Action in Freeway Pro now offers additional 
features—such as automatically populating the menu with the 
pages of your site and making the menu work well in a responsive 
layout for viewing on mobile devices.

The CSS 
Menus Action 
with the two 
new features 
highlighted

The Auto-generate Navigation Menu feature
For most Pro users, using the Auto-generate Navigation Menu 
feature in the Actions palette is a quick and simple way to build a 
navigation menu for your site. 

This works by Freeway taking the pages and page folders from the 
Site Panel of your file to build a list do display as main menus, sub-
menus and sub-sub-menus. However, for Freeway to populate the 
menu with the pages in their correct order the pages need to be 
listed in that order in the Site Panel.

We will now run through the steps on how to build a CSS Menu 
using the Auto-generate Navigation Menu feature which will work 
in the same way as the one in the screenshot on the next page. 

The CSS Menu in the screenshot above has four main menus 
(Welcome, Services, Galleries and Contact) with two sub-menus 
that drop down from the Galleries main menu, along with three 
sub-sub-menus which flyout from the Portraits sub-menu. It is 
important to work out which menus will have sub-menus as they 
need to be treated differently to normal pages in the Site Panel list.

To make it so the CSS Menus Action can auto-generate the menu 
the pages need to be set up as shown in the screenshot of the Site 
Panel below.

In the screenshot on the previous page you can see the structure 
of the pages and page folders used in the site. Note that the Home 
page and the Services are independent pages used at the base level 
of the page and folder structure—and that is because we want 
those to be main menu items in the finished navigation menu. 
However, you will notice that the Contact page (which is also just 
a main menu page that should be at the base level along with the 
Home and Services pages) is contained within a page folder—and 
that needs to be done due to a current limitation in Freeway 
whereby pages cannot be moved to a position below page folders 
in the Site Panel list. This means that to place the Contact in a 
position where it follows the Galleries page it needs to be placed 
inside its own page folder. This will make the Contact page appear 
as a main menu item with a hyperlink applied because there is 
only a single page in the folder.
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The Galleries page folder has two items inside it at the next 
level—a page called Weddings and another page folder (called 
Portraits). This will mean that the CSS Menu will show the word 
“Galleries” as a main menu entry, but the word will not be 
displayed as an active hyperlink but when moused over it will 
display “Weddings” and “Portraits” as sub-menus below the main 
menu. 

Because the Portraits entry has further sub-sub-menus, it has three 
pages (“Adults”, “Children” and “Pets”) inside that page folder so 
they will work as fly-outs from the Portraits sub-menu, as shown in 
the screenshot of the CSS Menu (at the top of this column).

The Titles of the pages (as shown in the Site Panel list) will be the 
wording used for the entries in the menus.

To recap, the following principles apply when using the Auto-
generate Navigation Menu feature:

•	 Main menu items need to be placed at the base level of the page 
and folder structure

•	 For each level of sub-menu (or sub-sub-menu) you need to 
create a page folder at the appropriate level in the page/folder 
structure to contain the sub-menu pages

•	 To add a new main menu item which uses no sub-menus but 
is after another main menu item which does have a sub-menu, 
place that page inside a page folder as a single page within 
that folder

•	 All pages and page folders in the Site Panel list will be 
displayed in the CSS Menu once the file has been published 
(unless they have been removed from the CSS Menu using the 
dedicated Action—see later). 

Note: When auto-generating your CSS Menu, the menu will use 
the Page Titles (as shown in the Inspector’s Title field and which 
appears in the Site Panel list). However, you can choose to use your 
own custom titles by using the Better Meta Action—see page 130.

Removing pages or page folders in the Site Panel list 
from the CSS Menu

There will be times when you don’t want all the pages in your Site 
Panel list to appear in the CSS Menu when using the Auto-generate 
Navigation Menu option. This might be when you have a Contact 
page which uses a contact form, and you don’t want to include the 
Success and Error pages, for example.

To prevent specific pages or page folders appearing in the CSS 
Menu, select the page or page folder in the Site Panel list, go to 
Page>Page Action (or Page>Folder Action) and choose Remove 
from CSS Menus.

If you decide later that you wish to include a page or page folder 
again, simply select the page or page folder in the Site Panel list 
and remove the Action.

The Responsive section
By default you need to click on the disclosure triangle to the left of 
this section’s name to see the options.

The options in this section are only used if you are building a 
responsive site—if you are not building a responsive site you can 
ignore this section completely.

•	 Show Icon at Breakpoint: When narrow media widths are 
set, it can often be the case that a CSS Menu is too wide for 
that particular breakpoints width, so Freeway lets you set up 
the CSS Menu so that the normal CSS layout changes to a 
specified graphic. This means that a CSS Menu which looks 
like this when viewed in a desktop browser: 

 
can be made to change so it displays a graphic (perhaps a 
“hamburger” icon like the one below, which is one of the 
most commonly-used icons for navigation menus) when the 
specified breakpoint is reached. 

 
To do this, click on this popup and choose the breakpoint you 
want to use from the list in the dropdown menu.

•	 Open Icon: Click on this popup then choose Select... to choose 
the graphic you want to use when the breakpoint is reached so 
that visitors can click on it to display a dropdown menu as a 
single column. 
  When the visitor clicks on the chosen icon, you will see a 
menu in a single column (indented for each level of sub-menu 
and sub-sub-menu) as shown below: 

 
  Note that the list of pages displayed when the breakpoint is 
reached will fill the entire height of the screen of an iPhone 
or other smartphone device. The colors used for the text and 
backgrounds of the list for Normal, Hover, Click and Current 
Page will be taken from the colors specified in the CSS Menus 
Action’s Links and Background panel. The color above and 
below the menu is set in Overlay Color (see later).

•	 Close Icon: Click on this popup to choose the icon you want to 
use for visitors to click on to close the menu. Choose from Use 
Open Icon (which will mean the the same icon used to display 
the menu will be used to close it) or choose Select... to choose 
your own custom icon.

•	 Menu Entrance: When the visitor clicks on the Open icon, 
the menu is displayed by the content sliding into view. This 
option lets you choose the direction the content slides in 
from. Choose From Top, From Right, From Bottom or From Left.
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•	 Overlay Color: Click on this popup to choose the color you 
want to display in the Open/Close icon bar and the space 
below the menu (a light grey was chosen for the screenshot on 
the previous page).

•	 Vertical Spacing: This value controls the amount of space used 
top and bottom of each page name in the single column list.

•	 Horizontal Inset: This value controls the amount of space used 
on the left of the menu. Note that this affects all items in the 
menu (main menus as well as sub-menus).

Advanced Responsive Options

This option is closed by default when viewing the Responsive 
panel. Click on the disclosure triangle to see the options:

•	 Close Icon Offset: These offset values affect the positioning of 
the chosen Close Icon image when the menu is displayed.

•	 Space Menu From Header: This value controls the spacing 
between the menu and the header area where the Close Icon 
appears.

The Responsive section of the Submenu 
Settings
When the Use Main Menu Settings option is checked there is just 
one option in the Responsive section.

•	 Increase Submenus Inset By: This value lets you choose the 
amount of inset (in pixels) that each level of sub-menu and 
sub-sub-menu is indented.

When the Use Main Menu Settings option is unchecked two 
further options appear in the Responsive section.

•	 Vertical Spacing: This value lets you choose the amount of 
spacing top and bottom of each of the sub-menus listed in the 
menu when the Open icon is clicked on. Note that this allows 
you to choose to set the sub-menus with a greater or lesser 
amount of space top and bottom than that applied to main 
menu items.

•	 Horizontal Spacing: This value lets you choose the amount of 
spacing to the left and right of each of the sub-menus listed 
in the menu when the Open icon is clicked on. Note that this 
allows you to choose to set the sub-menus with a greater or 
lesser amount of space top and bottom than that applied to 
main menu items.

3:  The Better Meta Action
A new Action which is built into Freeway Pro is the Better Meta 
Action which, among other things, offers advanced functionality 
for social media users.

To use the Action, select one of the pages in your Site Panel list 
and go to Item>Actions then choose Better Meta.

•	 Page Title: Enter the wording you wish to use for the Title 
of your web page. The Title is what you will see as the name 
of the page in the header bar of a browser window, and we 
recommend you enter up to 70 characters of keyword-relevant 
text. 
  Note that entering a different page title in this field will 
over-ride the title given in the Inspector’s General Settings 
tab and what is displayed in the Site Panel list. This means 
that you can use a short title to auto-generate the CSS Menu 
used on your file while still having full control over what is 
displayed for the page title in the browser and in search engine 
results.

•	 Page Description: Enter the wording you want to use for the 
Description meta tag for your page. We recommend that you 
enter a general description of what the site is about using up 
to 155 characters. If you use more words they may be ignored 
by search engines.

•	 Search: Both options in this panel are specifically for use with 
Google Plus accounts. 
G+ User ID: Enter your Google Plus ID in this field to display 
your name and avatar in any displayed Google search results. 
 

 
G+ Business ID: Enter the publisher’s Google Plus business 
page ID in this field to display their name and avatar in any 
displayed Google search results.

•	 Facebook and Google+: The options in this panel are 
specifically for use with both Facebook and Google Plus 
accounts. 
Page Type: Click on this popup to choose the type of page 
(choose from Website, Article or Blog). 
Title: Enter an appropriate title for your page (using up to 95 
characters) for your social media audience. 
Description: Enter up to 297 characters of description for your 
page so your social media audience will know what the page 
is about. 
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Image: Click on this popup then click on Select... to choose 
the image to display when people share this page. The 
recommended size is 1200 wide x 630 pixels). 
Site Name: Enter the name of your website in this field (note 
that this should be the site and not the URL). 
Page URL: Give the full web address of this page in here, 
including the domain name. Most commonly you do this by 
clicking on the popup, choosing Other... then entering the 
page URL in the External tab of the Edit Hyperlinks dialog. 
Facebook Admin IDs: If you have admin IDs set for your 
Facebook account, enter a comma separated list of those IDs in 
this field so they can access detailed analytics for that account.

•	 Twitter: The options in this panel are specifically for use with 
Twitter accounts. 
Type: Choose the type of card to be displayed. Choose from 
Summary (min image size 60x60), Summary with large image 
(min 230x150), Product, Photo, Player or App. 
Title: Enter a title for the page in this field, using up to 95 
characters, to appearl to your Twitter audience. 
Description: Enter a description for your page, using up to 297 
characters, which will be used when your page is shared. 
Image: Click on this popup then choose Select... to choose the 
image you want to display when the page is shared. 
Page URL: Give the full web address of this page in here, 
including the domain name. Most commonly you do this by 
clicking on the popup, choosing Other... then entering the 
page URL in the External tab of the Edit Hyperlinks dialog. 
Creator Username: Enter your Twitter handle to be given credit 
in the card (for example, @johnnyappleseed). 
Publisher Username: Enter the site/company Twitter handle to 
be given credit in the card (for example @softpress).

4:  The Table Styler Action
Getting an HTML table to look good in a website has always 
been a time-consuming and tedious business—especially when 
applying styling to a particularly large table (or selection of 
tables)—but the new Table Styler Action makes it quick and 
simple to do.

To use the Action, select an HTML table item on your page then 
go to Item>Actions and choose Table Styler.

With the item selected on your page you can see the options in 
the Actions palette.

•	 Odd Row Color: Apply a color for the top row of a table (ie, 
row one) and then every other row.

•	 Odd Row Opacity: Set the opacity for the color used for the 
Odd Row Color.

•	 Even Row Color: Apply a color for the second row of the table 
and then every other row. Used in conjunction with the Odd 
Row Color (so they are different colors) you can quickly set up 
alternating colors for the rows of the table.

•	 Even Row Opacity: Set the opacity for the color used for the 
Even Row Color.

•	 Cell Border Top Color: Choose a color to display as the border 
applied to the top of the table cells. Note that this will look 
strange if you have any Cell Spacing or Cell Padding applied 
in the Inspector. If you want to use any of the Border Color 
options, we recommend that you set the Cell Spacing and Cell 
Padding to zero pixels in the Inspector first. Also, note that if 
you use a Top Border Color and a Bottom Border Color, that 
will result in the Cell Border Size being double what is set in 
the Actions palette (if, for example you want a border of just 
2px between each row, only use Top or Bottom and not both).

•	 Cell Border Top Opacity: Set the opacity for the color used for 
the Cell Border Top Color. 

•	 Cell Border Bottom Color: Choose a color to display as the 
border applied to the bottom of the table cells.

•	 Cell Border Bottom Opacity: Set the opacity for the color used 
for the Cell Border Bottom Color.

•	 Cell Border Left Color: Choose a color to display as the border 
applied to the left of the table cells.

•	 Cell Border Left Opacity: Set the opacity for the color used for 
the Cell Border Left Color.

•	 Cell Border Right Color: Choose a color to display as the border 
applied to the right of the table cells.

•	 Cell Border Right Opacity: Set the opacity for the color used for 
the Cell Border Right Color.

•	 Cell Border Size: Set the width of the border you want to use 
for the Cell Borders (above). 

•	 Table Border Color: Apply a color to the outer border of the 
entire table. Note that this works in conjunction with the 
Border attribute set in the Inspector (so if the Border in the 
Inspector is set to 0px, then no outer border will display).

•	 Border Radius: Set a value for rounded corners on the outer 
border of the table. Note that this requires CSS3 for it to work, 
so it may not work in older browsers.

The following screenshots show the table and its settings in 
Freeway, and how the table appears when previewed in a browser.
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5:  Enhanced Google Analytics Action
The Google Analytics Action now supports Google’s latest 
“Universal Analytics”. Once you have applied the Action to a 
page or page folder you can see the options in the Actions palette.

•	 Tracking ID: When you sign up for Google Analytics at Google 
Webmaster Tools you will be supplied with a unique tracking 
code (which starts with UA-). Enter that tracking code in this 
field

•	 Domains to Track: Enter a comma separated list of domains to 
track in this field. Subdomains are automatically tracked when 
the primary domain is added. Don’t forget to exclude the 
domains in your Google Analytics settings to prevent the links 
from showing up as referrals

•	 Enhanced Link Tracking: Check this option to see separate 
information for multiple links on a page that all have the 
same destination. For example, if there are two links on the 
same page that both lead to the Contact Us page, then you see 
separate click information for each link

•	 Track Downloads: Check this option if you want to add a new 
event when zip files and/or PDF files are downloaded from 
your site

•	 Use Classic Code: If you wish you can add both Classic and 
Universal Analytics code to your pages by checking this 
option. Use this if you’re converting existing properties to 
Universal Analytics

•	 Classic Tracking ID: If you check the Use Classic Code option, 
enter your classic tracking ID (which was originally supplied 
by Google) in this field

6:  New HTML5 Section Elements
Figure Element

The figure element represents an illustration used on the page—
which equates to a figure being used in a book or journal. This 
HTML item will contain either a graphic item or a graphic item 
along with an HTML caption item (which will be assigned the 
Figure Caption section element, see below). Note that the figure 
element will be the parent item which contains the image or the 
image and caption (the image item itself will not be assigned a 
section element).

Figure Caption Element

This element works in conjunction with the figure element 
(above). The figure caption element is assigned to a child HTML 
text item which is embedded inside an HTML item which has the 
figure element assigned to it.

Main Element

The main element represents the HTML item which contains the 
main content area of the page. This item should be used for the 
text and/or content which is central to the main topic of the page 
it is used on.

Note that you should only use a single main element per page, 
and it can’t be assigned to an item which has an article, aside, 
footer, header, or nav element assigned to it.

The main element helps screen readers and other assistive 
technologies understand where the main (and most relevant) 
content begins on the page.

7:  New keyboard shortcuts
Many new keyboard shortcuts have been introduced into Freeway 
to enhance the workflow of those who like to have direct 
access to dialogs or other functionality that was only achievable 
previously by using the mouse (and sometimes only through 
clicking on dropdown menus).
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•	 Document Setup... (Control-Command-,): Use the shortcut 
to open the Document Setup dialog.

•	 Add Action... (Command-j): Use the shortcut to open the 
Actions palette so you can type in the name of the Action you 
want to apply. Note that this shortcut is “context sensitive”, so 
if you have nothing selected on the page the Add Page Action 
dialog opens but when a graphic item is selected on the page 
(for example) the Add Item Action (for a graphic item) dialog 
opens.

•	 Styles... (Control-Command-e): Use the shortcut to open the 
Edit Styles dialog.

•	 Custom Padding... (Alt-Command-,): Use the shortcut to 
open the Custom Padding dialog.

•	 Custom Margin... (Alt-Command-.): Use the shortcut to open 
the Custom Margins dialog.

•	 Insert HTML item (Control-Command-i): Use the shortcut to 
insert a new HTML item. This will work for a new standalone 
or a new inflow item.

•	 Insert Graphic item (Control-Command-Y): Use the 
shortcut to insert a new graphic item. This will work for a new 
standalone or a new inflow item.

•	 Next Page (Control-Command-]): Unlike the Back and 
Forward shortcuts (which jump back and forth to show the 
previously viewed pages) this short cut lets you display the 
next page in the Site Panel list.

•	 Previous Page (Control-Command-[): Use the shortcut to 
display the page above the currently displayed page in the Site 
Panel list.

•	 Next Media Type (Control-Command-L): Use the shortcut to 
toggle forwards through the row of Media Type buttons.

•	 Previous Media Type (Control-Command-k): Use the 
shortcut to toggle backwards through the row of Media Type 
buttons.

•	 Next Sibling (Control-Command-RightArrow): Use the 
shortcut to select the next item (at the same level in the 
parent/child hierarchy of items).

•	 Previous Sibling (Control-Command-LeftArrow): Use the 
shortcut to select the previous item (at the same level in the 
parent/child hierarchy of items)

•	 Select Child (Control-Command-DownArrow): Use the 
shortcut to toggle down through the hierarchy of parent/child 
items.

•	 Select Parent (Control-Command-UpArrow): Use the 
shortcut to toggle up through the hierarchy of parent/child 
items.

•	 Hide/Show Media Tabs (Alt-Command-j): Use the shortcut 
to toggle on or off the row of Media Buttons above the top left 
corner of the page area.


